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Abstract :  In recent years, the integration of the Internet of Things (IoT) into fitness applications has revolutionized workout 

tracking and performance analysis. This paper introduces an  IOT-BASED HEALTH MONITORING SYSTEM DURING PUSH-

UPS FOR SMARTER WORKOUTS, a device that utilizes IoT technology to monitor and track the number of push-ups performed 

during a workout session. The system consists of a wearable sensor or motion tracker that detects and records the user's movements, 

specifically the up-and-down motion of the push-up. The data is transmitted wirelessly via Bluetooth or Wi-Fi to a mobile 

application or cloud-based platform, where it is analysed in real-time to provide instant feedback on the user's performance. 

Additionally, the system tracks individual progress over time, offering personalized workout insights, statistics, and suggestions for 

improvement. By incorporating IoT sensors, real-time feedback, and data analytics, the push-up counter enhances workout 

efficiency and motivation, ensuring users stay informed about their performance and progress. This system is particularly beneficial 

for individuals aiming to improve their physical fitness, while also providing valuable data for trainers and fitness enthusiasts. The 

paper demonstrates the potential of IoT in transforming traditional fitness tracking and optimizing workout routines for more 

effective and smarter exercise regimens. 
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I. INTRODUCTION 

In today’s fast-paced world, fitness enthusiasts are constantly seeking smarter and safer ways to optimize their workouts. Push-

ups, being a fundamental exercise for strength building, are often performed without proper monitoring, which can lead to incorrect 

posture, fatigue, or even injury. To address these challenges, the "IoT-Based Health Monitoring System During Push-Ups for Smarter 

Workouts" project introduces an intelligent, real-time solution for exercise tracking and health management.This system integrates 

various sensors, including a heartbeat sensor to monitor the user’s heart rate, a tilt sensor to check body posture and push-up accuracy, 

an ultrasonic sensor to count repetitions by measuring body movement, and temperature and humidity sensors to monitor the workout 

environment. These sensors are connected to an ATMega 328P microcontroller, which processes the collected data and presents real-

time feedback on an LCD screen. Simultaneously, using WiFi communication, the system sends the data to a dedicated mobile app, 

allowing users to view their performance remotely and over time. For added safety, a GSM module is included to send SMS alerts if 

any abnormal readings are detected, such as sudden spikes in heart rate or signs of physical strain.By combining IoT technology with 

embedded systems, this project enables users to track their fitness metrics with precision, adjust their workouts accordingly, and 

reduce the risk of health complications. It not only promotes disciplined and safer exercise habits but also lays the foundation for 

integrating smart healthcare into everyday fitness routines, making workouts more data-driven, personalized, and effective. 

II. LITERATURE SURVEY 

Fitness monitoring has witnessed a surge in interest, with researchers and developers exploring innovative solutions to enhance 

the accuracy and engagement of exercise tracking.This Literaturesurvey provides an overview of existing studies, projects, and 

advancements related to IoT-based push-up counters in the realm of fitness monitoring.With the growing integration of the Internet 

of Things (IoT) in healthcare and fitness, there has been significant interest in developing systems that monitor physical activity and 

provide real-time feedback to users. The following review covers relevant research and developments related to IoT-based health 

monitoring, particularly during push-ups and other bodyweight exercises. 

1. IoT in Fitness and Health Monitoring 

Several studies, such as by Patel et al. (2012), have explored the role of wearable and non-wearable IoT devices in tracking health 

metrics like heart rate, body temperature, and movement patterns. These systems often use sensors like accelerometers, gyroscopes, 

and photoplethysmography (PPG) sensors integrated into wearable devices. 

 

2. Push-Up Monitoring Techniques 

Researchers have developed systems to analyze push-up form using motion sensors and video analysis. For instance, Kim et al. 

(2017) utilized inertial measurement units (IMUs) to track joint angles and push-up counts. These systems help in maintaining correct 

posture and reducing injury risk. 
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3. Real-Time Feedback Mechanisms 

Recent works (e.g., Yang & Zhang, 2020) focus on providing users with real-time feedback using mobile applications or smart 

mirrors. These systems enhance user engagement by offering corrections, motivational prompts, and performance summaries after 

each session. 

 

4. Edge and Cloud Computing in IoT Fitness Systems 

To handle the real-time data processing needs of such systems, edge computing is often used to reduce latency and improve 

responsiveness, as detailed in the work of Al-Turjman et al. (2019). This is particularly beneficial for time-sensitive activities like 

exercise form correction. 

III. SYSTEM DESIGN 

The  block diagram represents a smart monitoring system built around an ATMega 328P Microcontroller. The system integrates 

multiple sensors and modules to collect, process, and transmit data. A Mobile App communicates wirelessly through a WiFi module 

connected to the microcontroller, allowing real-time remote monitoring. Various sensors are attached: an Ultrasonic Sensor measures 

distance or object detection; a Tilt Sensor detects orientation or fall events; a Heartbeat Sensor monitors the heart rate of an individual; 

a Temperature Sensor captures ambient or body temperature; and a Humidity Sensor measures the surrounding humidity levels. All 

sensor data is fed into the ATMega 328P, where it is processed and analyzed. Output from the microcontroller is displayed on an 

LCD, providing immediate on-site feedback. Additionally, a GSM Module is connected to send important alerts via SMS to 

predefined mobile numbers in case of emergencies or threshold breaches. The entire setup is powered by a Power Supply to ensure 

continuous operation. This integrated system is ideal for health monitoring, environmental monitoring, and security applications. 

 
 

                  Fig.3.1:Block diagram of the System 

 

 

IV. HARDWARE AND SOFTWARE REQUIREMENTS 

4.1 Hardware Requirements 

1.Node MCU With Esp 8266 

NodeMCU is an open sce LUA based firmware created for ESP8266 wifi chip. By investigating usefulness with ESP8266 chip, 

NodeMCU firmware accompanies ESP8266 Development board/pack for example NodeMCU Development board.Since 

NodeMCU is open sce stage, their equipment configuration is open for alter/change/manufacture. NodeMCU Dev Kit/board 

comprises of ESP8266 wifi empowered chip. The ESP8266 is an ease Wi-Fi chip created by Espressif Systems with TCP/IP 

convention. For more data about ESP8266, we can allude ESP8266 Wi-Fi Module. There is Version2 (V2) accessible for NodeMCU 

Dev Kit for example NodeMCU Development Board v1.0 (Version2), which as a rule comes in dark shading PCB. 

2.Ultrasonic Sensor 

The HC-SR04 ultrasonic sensor is a widely used distance measurement sensor in various applications, including robotics, 

automation, security systems, and IoT-based smart projects. It operates using ultrasonic waves to detect obstacles and measure 

distances accurately. Due to its affordability, high precision, and ease of interfacing with microcontrollers like Arduino and 

Raspberry Pi, the HC-SR04 is a popular choice among engineers, students, and hobbyists. 

The HC-SR04 sensor operates on the principle of ultrasonic wave reflection. It consists of two main components: 
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1. Transmitter (Trigger) – This emits an ultrasonic pulse at a frequency of 40 kHz. 

2. Receiver (Echo) – This detects the reflected ultrasonic wave after it bounces off an object. 

3.Tilt Sensor 

An accelerometer is a device that measures the vibration, or acceleration of motion, of a structure. The force caused by vibration 

or a change in motion (acceleration) causes the mass to “squeeze” the piezoelectric material which produces an electrical charge 

that is proportional to the force exerted upon it. Since the charge is proportional to the force, and the mass is constant, then the 

charge is also proportional to the acceleration. These sensors are used in a variety of ways – from space stations to handheld devices 

– and there’s a good chance we already own a device with an accelerometer in it. For example, almost all smartphones today house 

an accelerometer. They help the phone know whether it undergoes acceleration in any direction, and it’s the reason why ourr phone’s 

display switches on when we flip it. In an industrial setting, accelerometers help engineers understand a machine’s stability and 

enable them to monitor for any unwanted forces/vibrations. 

A tilt sensor is a device used to measure the inclination and give digital output based on the angle of tilt. The sensor gives digital 

HIGH value when there is a tilt in the surface it is attached to. The original value of the sensor will be 0 (LOW). The Tilt sensor 

has three terminals. The Ground terminal of the sensor is connected to the ground line of the breadboard. 

4.Heartbeat Sensor 

Heartbeat Sensor is an electronic device that is used to measure the heart rate i.e. speed of the heartbeat. Monitoring body 

temperature, heart rate and blood pressure are the basic things that we do in order to keep us healthy. In order to measure the body 

temperature, we use thermometers and a sphygmomanometer to monitor the Arterial Pressure or Blood Pressure.Heart Rate can be 

monitored in two ways: one way is to manually check the pulse either at wrister neck and the other way is to use a Heartbeat 

Sensor.Monitoring heart rate is very important for athletes, patients as it determines the condition of the heart (just heart rate). There 

are many ways to measure heart rate and the most precise one is using an Electrocardiography But the more easy way to monitor 

the heart rate is to use a Heartbeat Sensor. It comes in different shapes and sizes and allows an instant way to measure the heartbeat. 

Heartbeat Sensors are available in Wrist Watches (Smart Watches), Smart Phones, chest straps, etc. The heartbeat is measured in 

beats per minute or bpm, which indicates the number of times the heart is contracting or expanding in a minute. 

5.DS18B20 Sesnor 

The DS18B20 is a widely used digital temperature sensor known for its accuracy and simplicity. It operates on a 1-Wire 

communication protocol, requiring only one data line (and ground) for communication with a microcontroller, making it highly 

efficient for multiple sensor deployments.  

The sensor supports a temperature range from -55°C to +125°C with an accuracy of ±0.5°C within the range of -10°C to +85°C, 

making it suitable for industrial and domestic applications. It offers a configurable resolution from 9-bit to 12-bit, allowing 

flexibility based on the requirements of the application. 

The DS18B20 has three pins: VCC (power supply ranging from 3.0V to 5.5V), GND (ground), and DATA (communication 

pin), which requires a 4.7kΩ pull-up resistor to maintain communication integrity. One of its major advantages is the unique 64-bit 

serial code embedded in each sensor, which enables multiple sensors to share the same data line, allowing simultaneous data 

collection. 

6.DHT11 Sensor 
The DHT11, there is a humidity sensing component along with a Thermistor. Humidity sensing component has two electrodes 

with moisture holding substrate sandwiched between them. The ions are released by the substrate as water vapor is absorbed by it, 

which in turn increases the conductivity between the electrodes.The change in resistance between the two electrodes is proportional 

to the relative humidity. Higher relative humidity decreases the resistance between the electrodes, while lower relative humidity 

increases the resistance between the electrodes.DHT11 also contains a NTC/Thermistor to measure temperature. A thermistor is a 

thermal resistor whose resistance changes drastically with temperature. The term “NTC” means “Negative Temperature 

Coefficient”, which means that the resistance decreases with increase of the temperature. 

On the other side, there is a small PCB with an 8-bit SOIC-14 packaged IC. This IC measures and processes the analog signal 

with stored calibration coefficients, does analog to digital conversion and spits out a digital signal with the temperature and humidity. 

At the heart of the module is the digital temperature & humidity sensor manufactured by AOSONG – DHT11.DHT11 can measure 

temperature from 0°C to 50°C with ±2.0°C accuracy, and humidity from 20 to 80% with 5% accuracy. Note that the sampling rate 

of the DHT11 is 1Hz, meaning you can get new data from it once every second. The module comes with all the essential supporting 

circuitry, so it should be ready to run without any extra component. 

 

7.Arduino Board 
It is a simple microcontroller board. It is an open source computing platform and has an environment for developing software 

for the Arduino board. It can be used to make computers. It is used to create interactive projects. It takes input from sensors or 

switches and controls the outputs. Arduino boards are inexpensive compared to other microcontroller based devices. It can stand-

alone or can communicate with the software of the computer. Arduino software can run on Windows, Linux and Macintosh OSX. 

It provides an Integrated Development Environment (IDE) which is written on Java for programming microcontrollers. 

It supports C, C++ programming languages. So anyone who knows the basic programming C can easily access Arduino IDE. It 

is very simple. Arduino has built-in functions. It can access serial port. It does not need to access the register details. It can simply 

call the functions and easily perform the functions. So the coding and debugging are fast and efficient. Arduino IDE displays the 

data which is into and out of the serial port.Arduino Uno is a microcontroller board based on 8-bit ATmega328P microcontroller. 

Along with ATmega328P, it consists other components such as crystal oscillator, serial communication, voltage regulator, etc. to 

support the microcontroller. Arduino Uno has 14 digital input/output pins (out of which 6 can be used as PWM outputs), 6 analog 

input pins, a USB connection, A Power barrel jack, an ICSP header and a reset button.   

8.Liquid-Crystal Display (LCD) 
A liquid-crystal display (LCD) is a flat-panel display or other electronically modulated optical device that uses the light-

modulating properties of liquid crystals combined with polarizers. Liquid crystals do not emit light directly, instead using 

a backlight or reflector to produce images in color or monochrome. LCDs are available to display arbitrary images (as in a general-

purpose computer display) or fixed images with low information content, which can be displayed or hidden, such as preset words, 

digits, and seven-segment displays, as in a digital clock.  
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They use the same basic technology, except that arbitrary images are made from a matrix of small pixels, while other displays 

have larger elements. LCDs can either be normally on (positive) or off (negative), depending on the polarizer arrangement. 

9.GSM 

GSM is a mobile communication modem; it is stands for global system for mobile communication (GSM). The idea of GSM 

was developed at Bell Laboratories in 1970. It is widely used mobile communication system in the world. GSM is an open and 

digital cellular technology used for transmitting mobile voice and data services operates at the 850MHz, 900MHz, 1800MHz and 

1900MHz frequency bands. 

GSM system was developed as a digital system using time division multiple access (TDMA) technique for communication 

purpose. A GSM digitizes and reduces the data, then sends it down through a channel with two different streams of client data, each 

in its own particular time slot. The digital system has an ability to carry 64 kbps to 120 Mbps of data rates. 

4.2Software required: 

1.Arduino IDE Software: 

In this section, we will learn in easy steps, how to set up the Arduino IDE on our computer and prepare the board to receive the 

program via USB cable. 

Step 1: − First we must have our Arduino board (we can choose our favorite board) and a USB cable. In case we use Arduino UNO, 

Arduino Duemilanove, Nano, Arduino Mega 2560, or Diecimila, we will need a standard USB cable (A plug to B plug), the kind 

we would connect to a USB printer as shown in the following image.In case we use Arduino Nano, we will need an A to Mini-B 

cable instead as shown in the following image. 

Step 2: − Download Arduino IDE Software 
We can get different versions of Arduino IDE from the Download page on the Arduino Official website. We must select  

software, which is compatible with  operating system (Windows, IOS, or Linux). After file download is complete, unzip the file. 

Step 3: − Power up  board 
The Arduino Uno, Mega, Duemilanove and Arduino Nano automatically draw power from either, the USB connection to the 

computer or an external power supply. If we are using an Arduino Diecimila, we have to make sure that the board is configured to 

draw power from the USB connection. The power source is selected with a jumper, a small piece of plastic that fits onto two of the 

three pins between the USB and power jacks. Check that it is on the two pins closest to the USB port.Connect the Arduino board to 

computer using the USB cable. The green power LED (labeled PWR) should glow. 

Step 4: − Launch Arduino IDE 
After our Arduino IDE software is downloaded, we need to unzip the folder. Inside the folder, we can find the application icon 

with an infinity label (application.exe). Double-click the icon to start the IDE. 

Step 5: − Open  first project 

Once the software starts, we have two options − 

 Create a new project. 

 Open an existing project example. 

To create a new project, select File → New. 

To open an existing project example, select File → Example → Basics → Blink.The Arduino Uno, Mega, Duemilanove and 

Arduino Nano automatically draw power from either, the USB connection to the computer or an external power supply. If we are 

using an Arduino Diecimila, we have to make sure that the board is configured to draw power from the USB connection. The power 

source is selected with a jumper, a small piece of plastic that fits onto two of the three pins between the USB and power jacks. 

Check that it is on the two pins closest to the USB port.Here, we are selecting just one of the examples with the name Blink. It turns 

the LED on and off with some time delay. We can select any other example from the list.11111111111 

Step 6: − Select  Arduino board 
To avoid any error while uploading program to the board, we must select the correct Arduino board name, which matches with 

the board connected to our computer. 

Go to Tools → Board and select  board. 

Here, we have selected Arduino Uno board according to tutorial, but we must select the name matching the board that we are 

using. 

Step 7: − Select  serial port 
Select the serial device of the Arduino board. Go to Tools → Serial Port menu. This is likely to be COM3 or higher (COM1 

and COM2 are usually reserved for hardware serial ports). To find out, we can disconnect our Arduino board and re-open the menu, 

the entry that disappears should be of the Arduino board. Reconnect the board and select that serial port. 

Step 8: − Upload the program to board 

Before explaining how we can upload program to the board, we must demonstrate the function of each symbol appearing in the 

Arduino IDE toolbar. 

Now, simply click the "Upload" button in the environment. Wait a few seconds; we will see the RX and TX LEDs on the board, 

flashing. If the upload is successful, the message "Done uploading" will appear in the status bar. 

4.2 Embedded C 

Embedded C Programming is the soul of the processor functioning inside each and every embedded system we come across in 

our daily life, such as mobile phone, washing machine, and digital camera. Each processor is associated with embedded software. 

The first and foremost thing is the embedded software that decides functioning of the embedded system.Embedded C language is 

most frequently used to program the microcontroller.Earlier, many embedded applications were developed using assembly level 

programming. However, they did not provide portability. This disadvantage was overcome by the advent of various high level 

languages like C, Pascal, and COBOL. However, it was the C language that got extensive acceptance for embedded systems, and it 

continues to do so. The C code written is more reliable, scalable, and portable; and in fact, much. 

Embedded C is a specialized version of the C programming language tailored for programming embedded systems. It allows 

direct interaction with the hardware, enabling the programmer to control microcontroller components like timers, input/output ports, 

memory, and communication interfaces such as UART, SPI, and I2C. Embedded C is highly efficient, producing compact code that 

runs quickly and uses minimal memory, which is essential for systems with limited resources. It supports low-level programming 

features such as bit manipulation, interrupt handling, and memory-mapped register access, making it ideal for real-time applications 
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where speed and timing are critical. Unlike standard C, Embedded C often includes additional extensions to better handle hardware-

specific operations, such as managing different address spaces or fixed-point arithmetic. It is widely supported across different 

microcontrollers and development environments, like Atmel Studio, MPLAB, KEIL, and the Arduino IDE. In embedded projects, 

including those based on the ATMega 328P microcontroller, Embedded C forms the backbone of the firmware that reads data from 

sensors, processes it, controls outputs like LCDs and GSM modules, and communicates with mobile apps or other systems 

efficiently and reliably. 

 

V. RESULTS AND DISCUSSION 

The push-up counter operates through the following sequential steps:The wearable sensor, positioned on the wrist or chest, 

continuously monitors movement during a workout session. The accelerometer detects vertical displacement, while the gyroscope 

measures angular velocity to differentiate between complete and incomplete push-ups.Once the sensor captures motion data, the 

microcontroller processes the signals and transmits them via Bluetooth or Wi-Fi to a connected mobile application or cloud 

server.The mobile or cloud-based system applies filtering algorithms to eliminate noise and inconsistencies in the raw sensor data. 

A threshold-based or machine-learning classification algorithm identifies valid push-ups. 

5.1. Implementation Strategy 

The wearable sensor prototype is built using an ultra-sonic sensor, ESP8266 microcontroller, and Dallas module. The sensor is 

attached to the user’s wrist or chest to monitor push-up movements accurately. 

Sensor Data Processing: The microcontroller runs signal processing algorithms to filter motion data. 

Mobile App Development: The app is developed using Flutter or React Native to support cross-platform compatibility. 

 

 
 

Fig.5.1: Temperature monitoring using DS18B20 Sensor  

The figure 5.1 shows, DS18B20 is a digital temperature sensor that operates using a 1-Wire communication protocol, means it 

requires only one data line and ground to communicate with a microcontroller.   

 
 

 Fig.5.2: Temperature and humidity monitoring using DHT11 Sensor 

The figure 5.2 shows, DHT11 is a digital sensor used for measuring temperature and humidity. It consists of a thermistor for 

temperature sensing and a capacitive humidity sensor. The sensor periodically measures environmental conditions and transmits the 

data as a digital signal.   
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Fig.5.3: Pulse Rate Monitoring using Pulse Oximeter  

The figure 5.3 shows a pulse oximeter,it is a non-invasive device used to measure pulse rate and blood oxygen saturation 

(SpO2).Pulse oximeters are widely used in healthcare settings to monitor cardiovascular health, detect hypoxia, and ensure adequate 

oxygen levels in patients.  

 

 
 

Fig.5.4: Counting Push-ups using Ultrasonic Sensor 

The figure 5.4 shows, Counting push-ups using an ultrasonic sensor involves detecting the distance between the sensor and the 

body during the exercise. The ultrasonic sensor, typically an HC-SR04, emits sound waves and measures the time it takes to bounce 

back after hitting the surface (such as the chest or face).   

 

  

 

Fig.5.5 A message by GSM Module 

The figure 5.5 shows a GSM (Global System for Mobile Communications) module is an electronic device that allows a 

microcontroller or embedded system to communicate over a cellular network. It uses a SIM card to establish a connection with the 

mobile network, enabling the system to send and receive SMS messages, make or receive voice calls, and access the internet using 

GPRS.  
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Fig.5.6 finding Position using Tilt Sensor 

The figure 5.6 shows a tilt sensor is an electronic device used to detect the orientation or inclination of an object relative to the 

ground. It senses changes in the position of an object and sends a signal when the angle of inclination crosses a certain threshold.  

VI. CONCLUION AND FUTURE SCOPE 

6.1 Concluison 

The proposed IoT-driven push-up counter provides a smart, automated, and efficient solution for tracking workout progress. By 

leveraging wearable sensors, real-time feedback, and cloud-based analytics, the system enhances exercise monitoring, optimizes 

performance, and motivates users to achieve their fitness goals. Future advancements in AI and integration with existing smart fitness 

ecosystems will further improve the system's capabilities, making it a valuable tool for fitness enthusiasts and trainers alike.   

6.2 Future Scope  
Advanced AI algorithms can analyse real-time data to provide feedback on posture, speed, and endurance, suggesting corrections 

to improve performance and prevent injuries. Seamless integration with smartwatches, fitness bands, and other wearables to track 

metrics such as heart rate, calorie burn, and fatigue levels during workouts. Use of cloud platforms and edge computing to process 

data instantly, allowing for faster and more accurate performance analysis. Implementation of gamified elements, such as virtual 

rewards and leaderboards, to encourage consistency and competitive spirit among users. Health data can be transmitted to fitness 

trainers or healthcare providers, enabling remote guidan 

7 ce and monitoring. Predictive models using machine learning can assess the risk of injuries and suggest preventive measures.  
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